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1 Vorbemerkungen  

LT-SPICE ist ein voll funktionsfähiger SPICE-Simulator der Firma Linear Technology, der besonders 

für die Simulation von Schaltreglern entwickelt wurde, aber auch für beliebige Schaltungen eingesetzt 

werden kann [1], [2]. Grundlage ist das Simulationsprogramm SPICE 3 der Universität Berkeley mit 

einigen sehr hilfreichen Ergänzungen der Firma Linear Technology.  

Die Eingabe der Schaltung erfolgt über ein Schematic-Capture-Werkzeug. Die gezeichnete Schaltung, 

in die auch die relevanten SPICE-Kommandos eingetragen werden, wird beim Starten des Simulators 

in eine Circuit-Datei umgewandelt und diese dann dem Simulator übergeben. Die Titelzeile und das 

.END-Statement werden nicht im Schaltplan angegeben; beide werden automatisch gesetzt. Die Be-

schreibung der Schaltung kann selbstverständlich auch direkt in Form einer Circuit-Textdatei erfolgen. 

Hierzu kann ein beliebiger Text-Editor (z.B. Notepad) oder besser der in LT-SPICE eingebaute Editor 

eingesetzt werden. – Es wird empfohlen, sich nebenbei mit den allgemeinen SPICE-Regeln vertraut zu 

machen. Dafür steht das Skript „Einführung in das Simulationsprogramm SPICE“ [3] zur Verfügung.  

Die Ergebnisse können anschließend als Kurven dargestellt werden. Sehr hilfreich ist dabei die Mög-

lichkeit, in der Schaltung mit der Maus auf einen Knoten zu zeigen und das Knotenpotential sofort gra-

fisch dargestellt zu bekommen. Ähnliches gilt auch für Ströme durch Bauteile. Im Ergebnisplot sind 

außerdem „Cursor-Messungen“ möglich. Auch mathematische Rechenoperationen können eingebun-

den werden. Kurzum: das Programm ist außerordentlich vielseitig und trotzdem leicht zu bedienen.  

Obwohl das Programm eine wirklich brauchbare Hilfe enthält, die einen raschen Einstieg erleichtert, 

soll in den folgenden Abschnitten eine kurze Anleitung in deutscher Sprache gegeben werden. 

2 Installation 

Bevor mit der Installation des eigentlichen Simulators begonnen wird, sollten einige Vorbereitungen 

getroffen werden. Danach wird das Programm LT-SPICE installiert. Da LT-SPICE das einfache Ein-

binden selbsterstellter Symbole gestattet, können anschließend auch solche Symbole in den Biblio-

theks-Ordner von LT-SPICE gebracht werden.  

2.1 Vorbereitungen  

 Einen Ordner Spicelib einrichten, z.B.  D:\Spicelib.  In diesem Ordner werden die Mo-

dell-Bibliotheken gesammelt. Am einfachsten ist es, den kompletten Ordner Spicelib vom 

Hochschul-Server [5] zu importieren und direkt unter D:\ zu platzieren.  

 Einen Ordner Circuit (für Circuit-Textdateien, Endung .cir) einrichten, z.B.  D:\Circuit.  

 Einen Ordner Schematic (für Schaltpläne, Endung .asc) einrichten, z.B.  D:\Schematic.  

2.2 Programm-Installation   

 Die Webseite von Linear Technology (www.linear.com) aufsuchen und die gepackte Datei 

LTspiceIV.exe importieren und irgendwo temporär speichern.  

 Von dort aus die Installation starten durch Doppel-Klick auf die Datei LTspiceIV.exe. Seit 

Windows 7 schlage ich vor, LT-SPICE direkt im Wurzelverzeichnis einer Festplatten-Partition 

zu installieren, also z.B. unter C:\LTC\LTspiceIV\, um Probleme mit der Benutzerkonten-

verwaltung zu vermeiden. Auch die Installation auf einem USB-Stick ist möglich.  

 Auf dem Desktop wird automatisch eine Verknüpfung mit LTspice IV hergestellt. Das Symbol 

erscheint auf dem Desktop.  

http://www.linear.com/software
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 In LT-SPICE stehen praktisch alle wichtigen Symbole für das Zeichnen von Schaltungen zur 

Verfügung. Es besteht aber die Möglichkeit, eigene Schaltzeichen zu entwerfen und diese in LT-

SPICE einzubinden. So sind z.B. im Unterordner sym_neu des Ordners Neue Symbole [4] 

einige von mir abgeänderte und auch einige neue Symbole zusammengestellt (Endung .asy). 

Dazu gehört z.B. das europäische Zeichen für den ohmschen Widerstand. Der komplette Inhalt 

des Ordners sym_neu wird einfach in den LT-SPICE-Ordner sym kopiert. Ziel-Pfad: C:\ 

LTC\LTspiceIV\lib\sym\. Dort vorhandene Symbole, die denselben Namen haben wie 

Elemente aus dem Ordner sym_neu, werden dabei allerdings überschrieben. Dies gilt z.B. für 

den Widerstand. Da diese Prozedur nach jedem Programm-Update von LT-SPICE erforderlich 

wird, kann die kleine Batch-Datei Symbole.bat – zu finden ebenfalls im Ordner  Neue 

Symbole – die Arbeit erleichtern. Sie braucht nur durch einen Doppel-Klick gestartet zu wer-

den. Voraussetzung dafür ist allerdings, dass der Ordner sym_neu vorher im Ordner lib plat-

ziert worden ist und der oben angegebene Ziel-Pfad gültig ist.  

3 Zeichnen einer zu simulierenden Schaltung  

Das Entstehen einer Schaltung wird am besten anhand eines einfachen Beispiels beschrieben. Wir wäh-

len hier einen Verstärker mit nur einem Bipolar-Transistor, siehe Bild 5. Die Schaltung soll hier den 

Namen Verst-1.asc erhalten und in einem Unterordner des vorbereiteten Ordners  Schematic 

(siehe Abschnitt 2.1) abgespeichert werden. Der Unterordner erhält den Namen Projekt_1. 

3.1 Platzieren der Bauelemente  

Die einzelnen Arbeitsschritte werden nun der Reihe nach aufgelistet und zum Teil kurz erläutert:  

____________________________ 

1)
 Die Shortcuts (in Klammern) werden später im Abschnitt 8.5 erläutert.  

____________________________ 

 Starten des Programms LT-SPICE durch Doppel-Klick auf das Symbol:  

 Öffnen einer „Neuen Schaltung“ durch Links-Klick auf die entspre-

chende Schaltfläche, siehe Bild 1 oder Shortcut Ctrl N.  

 Am besten gleich speichern: File → Save As in den Unterordner Projekt_1 des Ordners 

Schematic, z.B.  D:\Schematic\Projekt_1\Verst-1.asc. Später kann dann ein-

fach mittels des Windows-Befehls Ctrl S gespeichert werden, weil dann der Pfad bekannt ist.  

 Grid-Punkte können durch den Shortcut Ctrl G aus- oder eingeschaltet werden. Außerdem stehen 

„Zoom-Werkzeuge“ zur Verfügung, siehe Bild 1.  

 Das Einstellen von Farben und anderen Optionen wird später im Abschnitt 8.5 erläutert. Dies 

würde an dieser Stelle nur den raschen Einstieg in das Programm stören.  

 
 Bild 1: LT-SPICE-Werkzeugleiste 1) 
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 Anmerkung: Durch Zeigen mit dem Maus-Cursor auf Teile in der Schalung erhält man in der 

Statuszeile (linke untere Bildschirm-Ecke von LT-SPICE) hilfreiche Informationen.  

 Links-Klick auf das zu platzierende Bauelement, siehe Bild 1. Einfacher ist es, Shortcuts zu 

verwenden. So erscheinen die Elemente „R“, „C“, „L“ bzw. „D“ einfach durch Tippen der ent-

sprechenden Buchstaben  
auf der Arbeitsfläche. 

Alle weiteren Bauele-

mente können über den 

Shortcut „I“ (dieser 

Shortcut muss noch de-

finiert werden, siehe Ab-

schnitt 8.5) in der Sym-

bol-Bibliothek erreicht 

werden: Über das sich 

öffnende Dialogfeld „Se-

lect Component Sym-

bol“, siehe Bild 2, kann 

das gewünschte Bau-

element gesucht werden. 

Soll z.B. ein NPN-

Transistor in der Schal-

tung verwendet werden, 

reicht es bereits aus, die 

beiden ersten Buchsta-

ben in die „Bauteil-

Zeile“ des Dialogfeldes 

einzutippen (Bild 2). Oft 

stehen mehrere Symbole 

zur Auswahl. Das Aus-

sehen eines Symbols hat 

keinen Einfluss auf  das 

spätere Simulationser-

gebnis. Wichtig ist nur, 

dass die Zahl der An-

schlüsse und deren Rei-

henfolge mit den Anga-

ben im verwendeten 

SPICE-Modell überein-

stimmen.  

 Vor dem Absetzen  eines 

Bauelementes, d.h. so-

lange es noch selektiert 

ist, kann es gespiegelt 

(Shortcut Ctrl E) oder 

gedreht (Ctrl R) werden. 

Später können der Ver-

schiebe- oder der Streck-Befehl (M oder F8, vergleiche Bild 4) zum Selektieren verwendet wer-

den. Werden dann die Werkzeug-Symbole zum Spiegeln bzw. Drehen angeklickt, darf man sich 

nicht daran stören, dass die selektierten Bauteile mit der Maus mitgenommen werden.  

Bild 3: Platzierung der Bauelemente 
 

 

 

Bild 2: Auswahl eines Bauelementes 
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 Hinweis: Einige Bauelemente enthalten zur Kennung des positiven Anschlusses eine kleine 

Markierung. Obwohl diese für nichtgepolte Elemente, wie z.B. für Widerstände und normale 

Kondensatoren, eigentlich nicht erforderlich ist, kann sie zur Erkennung der Stromrichtung hilf-

reich sein: Der vom positiven zum negativen Knoten fließende Strom wird bekanntlich als posi-

tiv definiert.  

 In unserem Beispiel werden insgesamt sieben Widerstände, drei Kondensatoren, ein NPN-

Transistor und zwei Spannungsquellen benötigt. Für die Eingangsspannung wird das Symbol 

„Signal“ gewählt. Die Bauelemente könnten z.B., wie in Bild 3 gezeigt, angeordnet werden. 

Achtung: Nicht das GND-Symbol vergessen!  

3.2 Verbindungen herstellen  

Das Herstellen der Verdrahtung ist in LT-SPICE sehr einfach. Die wichtigsten Arbeitsschritte:  

 Auswahl des Werkzeuges „Leitung“ (Wire, Shortcut F3), siehe Bild 4.  

 Durch Links-Klick und Bewegen der Maus können dann die Leitungen (Wire) gezeichnet wer-

 

Bild 5:  

Fertige Schaltung 
mit Simulationsan-
weisung  

Das Modell steht hier 
direkt im Schaltplan 
und kann einfach edi-
tiert werden. 

Im Normalfall ist es 
günstiger, die Biblio-
theks-Anweisung mit 
dem kompletten Spei-
cher-Pfad des Mo-
dells in den Schalt-
plan zu schreiben.  

 

 Bild 4: Weitere Zeichenwerkzeuge
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den. Sie dürfen auch durch ein Bauteil hindurch gelegt werden. Durch Rechts-Klick oder Esc 

wird der Vorgang abgeschlossen. Dann werden Kurzschlüsse zwischen Bauteil-Anschlüssen au-

tomatisch beseitigt.  

 Das Werkzeug „Strecken“ (Drag, Shortcut F8) dient zum Verändern von Leitungslängen oder 

allgemein zum Strecken. Zuerst wird das Werkzeug ausgewählt. Dann wird mit gedrückter lin-

ker Maus-Taste ein Rechteck um den zu streckenden Bereich gezeichnet, um ihn zu selektieren 

und das Strecken durch Bewegen der Maus vorgenommen. Die Verbindungen bleiben dabei er-

halten. Der Vorgang wird durch Rechts-Klick oder Esc abgeschlossen.  

 Das Werkzeug „Verschieben“ (Move, Shortcut M) dient, wie der Name schon ankündigt, zum 

Verschieben. Die Handhabung ist vergleichbar mit dem „Strecken“, allerdings werden nur selek-

tierte Bereiche verschoben. Die Verbindungen werden nur mit verschoben, wenn sie auch selek-

tiert sind. Der Vorgang wird durch Rechts-Klick oder Esc abgeschlossen.  

 Weitere wichtige Werkzeuge: Löschen (F5 oder Del), Undo (Ctrl Z) und Redo (Ctrl Y).  

 Leitungen können gekreuzt werden. Dabei entsteht keine Verbindung an der Kreuzungsstelle. 

Um eine Verbindung herzustellen, muss eine Leitung bis zum Anschlusspunkt geführt und dann 

durch Links-Klick die Verbindung hergestellt werden. Der Vorgang wird durch Rechts-Klick 

oder Esc abgeschlossen. Die fertig verdrahtete Schaltung ist in Bild 5 wiedergegeben.  

 Es gibt auch die Möglichkeit, „Linien“ zu zeichnen. Linien sind keine Leitungen und erscheinen 

nicht in der SPICE-Circuit-Datei. Sie können aber zur Hervorhebung oder Umrandung dienen. 

Das Linien-Werkzeug wird mit dem Shortcut Ctrl L gestartet. Durch Rechts-Klick auf die ge-

zeichnete Linie öffnet sich ein Menü, das nachträglich die Einstellung des Linien-Stiels gestattet.  

3.3 Attribute der Bauelemente  

Nachdem die Leitungen verlegt sind, müssen die einzelnen Bauelemente Namen erhalten und mit Wer-

ten versehen werden. Es sei an dieser Stelle angemerkt, dass es in SPICE zwei verschiedene Arten von 

Bauelementen gibt: 1) einfache, zweipolige Elemente, wie z.B. Widerstände, Kondensatoren, Spulen 

und unabhängige Quellen, für die oft die Angabe eines Wertes oder weniger Parameter schon ausreicht 

und 2) komplexere Bauteile, die zur näheren Beschreibung eine Modell-Anweisung erfordern (Dioden, 

Transistoren, Subcircuits usw.). Im Folgenden werden die Arbeitsschritte kurz erläutert:  

 Im einfachsten Fall reicht es aus, durch Rechts-Klick auf die Attribute „Bauteil-Name“ (z.B. R3) 

bzw. „Bauteil-Wert“ (z.B. R) ein kleines Dialogfeld zu öffnen, um die Einträge zu ändern.  

 Durch Zeigen auf das Bauelement mit der Maus und Rechts-Klick kann ein anderes Dialogfeld 

geöffnet werden, das die Auswahl von Bauelementen gestattet, für die in LT-SPICE fertige Mo-

delle existieren. Für einen integrierten MOS-FET (mit vier Anschlüssen) wird ein abgeändertes 

Dialogfeld geöffnet. Dieses gestattet den Eintrag der relevanten geometrischen Abmessungen. 

Auch bei Spannungs-oder Stromquellen kann diese Prozedur verwendet werden.  

 Durch Zeigen auf das Bauelement mit der Maus und Ctrl und Rechts-Klick wird ein  allgemei-

nes Dialogfeld geöffnet, das die wichtigsten Einträge gestattet. Von dieser Möglichkeit wird häu-

fig Gebrauch gemacht, siehe Bild 6. Durch Doppel- oder Rechts-Klick auf eine Zeile in der 

Spalte „Value“ wird ein Editieren der betreffenden Zeile ermöglicht. – Bei einem integrierten 

MOS-FET sind oft neben der Nennung der Hauptmaße W, L und dem Vervielfachungsfaktor M 

die Angaben AD, AS, PD und PS für die Berechnung der Drain- und Source-Gebiete erforderlich. 

Diese können dann einfach der Reihe nach in die Zeilen „SpiceLine“ und „SpiceLine2“ ge-

schrieben werden. Eine Reihenfolge ist nicht zu beachten. Möchte man die Angaben W, L und M 

im Schaltplan sichtbar haben, ist es am besten, W und L in der Zeile „Value“ anzugeben und M in 

der Zeile „Value2“ (oder auch umgekehrt). Der Transistor-Typ wird am besten in die Zeile 

„SpiceModel“ geschrieben. Durch Doppel- oder Rechts-Klick in der Spalte „Vis.“ kann ein 
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Kreuz gesetzt werden, um das betreffende Attribut im Schaltplan sichtbar zu machen. Und so er-

scheinen die Einträge in der Netzliste (allgemeine Syntax):  

<Name> Knoten1 Knoten2 [...] <SpiceModel>  

+   <Value> <Value2> <SpiceLine> <SpiceLine2>  

 Die Position eines Attributes kann durch vorheriges Aktivieren des Verschiebe- oder auch des 

Streck-Werkzeuges (M oder F8) und Links-Klick auf das betreffende Attribut verändert werden. 

Rechts-Klick oder Esc beendet den Vorgang wieder.  

 Bei aktiven Bauelementen, wie z.B. Transistoren wird als „Wert“ der Bauteil-Typ angegeben. In 

unserem Beispiel wird der Transistor-Typ „C3ZN02“ verwendet. Als Name wird „Q1“ vergeben.  

 Die Spannungsquelle VCC für die Versorgungsspannung VCC ist eine reine DC-Quelle. Als At-

tribute reichen der Name „VCC“ und der Wert „12V“ aus.  

 Für die Eingangsquelle könnte prinzipiell das gleiche Symbol verwendet werden wie für die Ver-

sorgungsspannung, da die Form für SPICE keine Bedeutung hat. Es kann aber auch eine Signal-

Quelle eingesetzt werden. Für eine solche existiert ein Dialogfeld, das durch Rechts-Klick auf 

das Bauelement geöffnet werden kann und dann eine genaue Spezifikation der Quelle erlaubt. – 

Ich bevorzuge die Verwendung des allgemeinen Attribut-Fensters, siehe Bild 6. Der Eintrag „AC 

1V“ wird für die AC-Analyse benötigt, und durch „Sin(0V 250mV 10kHz)“ wird eine sinusför-

mige Spannungsquelle mit dem DC-Wert 0 V, der Amplitude 250 mV und der Frequenz 10 kHz 

spezifiziert. Die beiden Zeilen dürfen auch vertauscht werden. Die Angabe in nur einer der bei-

den Value-Zeilen ist ebenfalls zulässig. – Nähere Informationen zur Spezifikation von unabhän-

gigen Spannungsquellen sind in der „eingebauten“ Hilfe, den Skripten der Firma Linear Techno-

logy [1] und [2] oder im Skript „Einführung in das Simulationsprogramm SPICE“ [3] zu finden.  

 Der Lastwiderstand RL soll in diesem Beispiel parametrisch zugewiesen werden. Als Wert wird 

deshalb ein Parameter in geschweiften Klammern eingetragen. Dies kann ein beliebiges Zeichen 

sein, z.B. {a} oder besser: {RL}. Die Definition des Parameters erfolgt später.  

3.4 Knoten-Namen  

Beim Erstellen des Schaltplans werden vom Programm automatisch Knoten-Namen vergeben. Sehr 

viel sinnvoller ist es jedoch, eigene Namen vorzugeben. Die Arbeitsschritte:  

 
Bild 6:  

Allgemeines Fenster zum 
Editieren der Bauelement-
Attribute  

Es wird geöffnet durch Zeigen 
auf das Bauelement und dann:  

Ctrl und Rechts-Klick.  

Die Einträge können nach ei-
nem Rechts- oder Doppel-
Klick editiert werden.  

Wird in der Spalte „Vis.“ ein 
Kreuz gesetzt, wird der zuge-
hörige Eintrag im Schaltplan 
sichtbar.  
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 Auswahl des Werkzeuges „Knoten-Name“ (Label Net, Shortcut F4), siehe Bild 4. Es öffnet sich 

ein kleines Dialogfeld, das zur Gestaltung des Knotens dient.  

 Zunächst wird der Knoten-Name in das editierbare Feld „ABC“ eingetragen. Dies reicht für die 

meisten Knoten bereits aus. Als Knoten-Namen sind prinzipiell alle Zeichen erlaubt, bis auf Son-

derzeichen. – Zusätzlich besteht die Möglichkeit, über „Port Type“ den Knoten als Eingangs- 

Ausgangs- oder bidirektionalen Knoten zu definieren. Dies hat nur für das Aussehen der Schal-

tung eine Bedeutung, nicht aber für SPICE.  

 Nach dem Drücken von „OK“ kann der Knoten-Name platziert werden. Wichtig ist, dass der 

Markierungspunkt wirklich genau auf eine Leitung oder deren Ende gesetzt wird! Der „Port 

Typ“ wird erst sichtbar, wenn der Knoten-Name genau das Ende einer Leitung trifft.  

3.5 SPICE-Befehle und Netzlisten-Zeilen, Kommentar-Text  

LT-SPICE bietet die besondere Möglichkeit, SPICE-Befehle und Netzlisten-Zeilen direkt in den 

Schaltplan schreiben zu dürfen. Dies macht eine Simulationsschaltung sehr übersichtlich. Alle Infor-

mationen, die für die Simulation relevant sind, stehen direkt in der Schaltung und brauchen nicht um-

ständlich über Dialogfelder zur Anzeige gebracht zu werden. Die wichtigsten Arbeitsschritte werden 

im Folgenden kurz erklärt:  

 Auswahl des Werkzeuges „SPICE“ (Shortcut S), siehe Bild 4.  

 In das sich öffnende Text-Fenster können direkt die SPICE-Befehle (Dot-Kommandos) oder 

Netzlisten-Zeilen geschrieben werden. – In unserem Beispiel wird zunächst der Parameter des 

Lastwiderstandes RL definiert: .Param RL = 22k (nähere Informationen zur Parameter-

Anweisung siehe Hilfe oder [1], [2] oder „Einführung in das Simulationsprogramm SPICE“ [3]). 

– Des Weiteren muss angegeben werden, wo SPICE das Modell des Transistors findet. Entweder 

direkt im Schaltplan: .Model C3ZN02 NPN (IS=1.1e-16 BF=190 ...) oder durch die 

Bibliotheks-Anweisung: .Lib D:\Spicelib\C36\C3Z-N.phy (Angabe des kompletten 

Pfades; dies ist die bevorzugte Methode). – Durch eine weitere Zeile wird die Simulationsanwei-

sung spezifiziert: .TRAN 0.2ms. In LT-SPICE reicht es für die Transienten-Analyse in vielen 

Fällen bereits aus, nur die Endzeit, hier 0,2 ms, anzugeben.  

 Die Anordnung von SPICE-Zeilen im Schaltplan ist beliebig. Sie kann sogar senkrecht erfolgen.  

 Sollen im Fenster für SPICE-Direktive mehrere Zeilen untereinander geschrieben werden, wird 

eine neue Zeile mit dem Shortcut Ctrl M gestartet. – Lange Zeilen können geteilt werden. Wie 

beim Schreiben einer Circuit-Datei ist dann aber darauf zu achten, dass jede Zeilen-Fortsetzung 

mit einem Pluszeichen (+), gefolgt von mindestens einem Leerzeichen, beginnt, siehe Bild 7.  

 

 
Bild 7:  

Angabe eines Bauelementes als Netzlisten-Zeile  

Hier liegt die Spannungsquelle „Vin“ zwischen den Knoten 
„3“ und „0“. Danach folgt die Wertangabe „Sin(0V ….“.  

Passt die gewünschte Anweisung nicht in eine Zeile, kann 
eine neue Zeile begonnen werden (Ctrl M). Die Fortset-
zung muss mit einem Pluszeichen (+) beginnen, gefolgt 
von mindestens einem Leerzeichen.  

Das Fortsetzungszeichen (+) wird nicht verwendet, wenn 
eine neue Anweisung beginnt!  
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 In LT-SPICE können Bauteile statt durch Symbole auch durch Netzlisten-Zeilen in der Schaltung 

definiert werden. Von dieser Möglichkeit kann vorteilhaft Gebrauch gemacht werden, wenn Bau-

teile nicht direkt zur Schaltung dazugehören, wie z.B. externe Spannungs- oder Stromquellen 

(vergl. Bild 7) oder auch externe Beschaltungen von Operationsverstärkern usw.  

 Für Kommentar-Text steht das Werkzeug „Kommentar“ (Shortcut T), siehe Bild 4, zur Verfü-

gung. Kommentar-Text ist nicht SPICE-relevant und dient nur zur Erläuterung. Der Text kann 

auch senkrecht dargestellt werden.  

 Wenn eines der Fenster, SPICE-Direktive oder Kommentar, geöffnet ist, kann nachträglich noch 

die Bedeutung geändert werden. Dies kann durch die entsprechende Markierung erfolgen: 

Comment oder SPICE directive.  

 Wenn die Schaltung fertig ist, sollte mit dem bekannten Shortcut Ctrl S gespeichert werden. Dies 

ist zwar keine Voraussetzung für die nachfolgende Simulation, ist aber dennoch sinnvoll.  

4 Die SPICE-Circuit-Datei  

LT-SPICE wandelt die gezeichnete Schaltung schon vor Beginn der Simulation in eine Circuit-Datei 

um. Diese wird automatisch erzeugt. Sie kann nach der Schaltungseingabe durch View SPICE Netlist 
dargestellt werden. Zu der in Bild 5 gezeigten Schaltung hat sie folgendes Aussehen:  

* D:\Schematic\Projekt_1\Bild 5.asc 

R2 In 0 120k 

Q1 Out In 5 0 C3ZN02 

R4 5 C3 560 

R3 VCC Out 10K 

R1 VCC In 390k 

VCC VCC 0 12V 

C1 2 In 270nF 

Vin 3 0 AC 1V Sin(0V 250mV 10kHz) 

C2 Out 6 330nF 

RL 6 0 {RL} 

Rg 2 3 4k 

R5 C3 0 3.3k 

C3 C3 0 10µF 

.TRAN  0.2ms 

.Model C3ZN02 NPN (IS=1.1e-16 BF=190  ...) 

.Param RL = 22k 

.backanno 

.end 

Diese Datei mit der Endung .net erscheint in dem Verzeichnis, in dem auch die Schaltung gespei-

chert ist. Sie wird normalerweise nach dem Schließen von LT-SPICE wieder gelöscht, kann aber auch 

erhalten werden (entweder: alles Markieren, dann Ctrl C (in die Zwischenablage kopieren) und dann 

als Text-Dokument mit der Endung .net speichern. Oder: Tools → Control Panel → Operation → 

Automatically delete .net files → No). – Das einzige ungewohnte Kommando .backanno dient 

dazu, während der Simulation dem Ergebnis-File (RAW-Datei, Endung .raw) Informationen zuzuset-

zen, die später das Darstellen von Strömen in Bauteil-Knoten mittels Maus-Klick ermöglicht.  

Die Netzliste wird normalerweise nicht weiter benötigt. Wenn jedoch irgendwelche Fehler auftreten 

und die Simulation vielleicht nicht startet, kann ein Blick auf die Netzlisten-Zeilen oft helfen, triviale 

Fehler zu entdecken.  
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5 Starten der Simulation und Ergebnis-Darstellung  

Wie eingangs schon erwähnt, wird die Schaltung automatisch in eine Simulationsdatei (Netzliste mit 

SPICE-Befehlen) umgewandelt und dient als Eingangs-File für die Simulation. – Gestartet wird die 

Simulation durch Links-Klick auf das „Run-Männchen“, siehe Bild 8. Durch Links-Klick auf die 

Schaltfläche „Halt“ kann die Simulation angehalten werden. Für beide Befehle können Shortcuts defi-

niert werden. Ich verwende die Leertaste für das Starten und H für das Stoppen. Wie die Shortcuts 

eingerichtet werden, wird im Abschnitt 8.5 erläutert.  

Im Folgenden werden für die in Bild 5 gezeigte Schaltung einige Simulationen beschrieben und die 

Darstellung der Ergebnisse erläutert. 

5.1 Arbeitspunkte der einzelnen Bauelemente (.OP) 

Die einfachste Analyse ist die Bestimmung der Arbeitspunkte der in der Schaltung verwendeten Bau-

elemente. Das sind die DC-Knoten-Potentiale und die Ströme durch die Bauelemente. Die wichtigsten 

Arbeitsschritte werden kurz aufgelistet:  

 In der Schaltung Bild 5 die Transienten-Anweisung .Tran 0.2ms entfernen und durch die 

Arbeitspunkt-Anweisung .OP (Operation Point) ersetzen, damit nur die Arbeitspunkte ermittelt 

und sofort angezeigt werden.  

 Simulation starten, siehe Bild 8. Danach erscheint sofort das Ergebnis der Analyse in Form einer 

Tabelle, siehe Bild 9.  

 Die Ergebnisse werden darüber hinaus in der TL-SPICE-Statuszeile (ganz unten links) angezeigt, 

wenn man mit der Maus auf einen Knoten oder Bauteil-Anschluss zeigt.  

 

  Bild 8: Weitere Werkzeuge 
 

Bild 9: Ergebnisse der DC-Arbeitspunkt-Analyse (Auszug) 
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 Während einer AC-Analyse werden zusätzlich auch die Kleinsignal-Parameter der Halbleiter-

Bauelemente berechnet, wie beispielsweise die innere Steilheit gm (ohne Bahnwiderstände) und 

die wirksamen Kapazitäten im Arbeitspunkt. Diese Ergebnisse werden ins Error-Log-File ge-

schrieben. Sie können durch View → SPICE Error Log sichtbar gemacht werden. Diese Datei 

ist normalerweise nicht permanent. Sie kann aber auf zweierlei Weise gespeichert werden. Ent-

weder: alles Markieren → Ctrl C (in die Zwischenablage kopieren) und dann als Text-

Dokument speichern (mit der Endung .log). Oder: Tools → Control Panel → Operation → 

Automatically delete .log files → No. Diese letzte Methode führt aber im Laufe der Zeit zu viel 

Daten-Müll!  

5.2 Darstellung der Ergebnisse der Analysen .DC, .AC und .Tran  

In den meisten Anwendungen möchte man nicht nur die Ergebnisse für einen Arbeitspunkt haben, son-

dern interessiert sich vielmehr für die Abhängigkeit der Ergebnisse von Spannungen, Strömen, der 

Temperatur, der Frequenz oder der Zeit. Hierfür sind bekanntlich die DC-Analyse (.DC), die AC-

Analyse (.AC) und die Transienten-Analyse (.Tran) vorgesehen. Auf die Einzelheiten soll an dieser 

Stelle nicht weiter eingegangen werden. Nähere Informationen hierzu sind in der „eingebauten“ Hilfe 

oder im Skript „Einführung in das Simulationsprogramm SPICE“ [3] oder in [8] zu finden. Im Folgen-

den soll aber kurz die grafische Darstellung der Simulationsergebnisse am Beispiel einer Transienten-

Analyse für die Schaltung Bild 5 beschrieben werden.  

 In der Schaltung Bild 5 die Arbeitspunkt-Anweisung .OP entfernen und wieder durch die Tran-

sienten-Anweisung .Tran 0.2ms ersetzen. Hierzu kann auch das LT-SPICE-Fenster zum Edi-

tieren der Simulations-Kommandos dienen, siehe Bild 10. Zunächst wird für die Art der Analyse 

die entsprechende Registerkarte gewählt, hier z.B. Transient. Danach können entweder die vor-

bereiteten Felder ausgefüllt werden oder man schreibt gleich die Anweisung in das untere Kom-

mando-Fenster. Die Syntax ist zur Erinnerung über dem Kommando-Fenster angegeben (siehe 

braune Pfeile). Nach dem Drücken von OK kann dann die neue Anweisung platziert werden. Der 

Punkt vor der .OP-Anweisung wird automatisch durch ein Semikolon ersetzt, wodurch die An-

weisung ausgeschaltet und das neue Kommando wirksam wird.  

 Simulation starten durch Links-Klick auf das „Run-Männchen“ (Leertaste), siehe Bild 8.  

 Links-Klick auf das Feld „Kurve auswählen“, siehe Bild 8.  

 
Bild 10:  

Fenster zum Editieren der 
Simulations-Kommandos.  

 

Es wird wie folgt geöffnet:  

Werkzeugleiste →            
Schaltfläche Simulate →  
Edit Simulation Cmd.  
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 Es öffnet sich ein Fenster „Select Visible Waveforms“. Nach dem Auswählen eines Knoten-

Potentials oder eines Bauelement-Stromes wird das Simulationsergebnis als Plot dargestellt. – 

Die Auswahl ist nicht auf die Darstellung einer Kurve beschränkt: Bei gleichzeitigem Drücken 

der Ctrl-Taste können auch mehrere markiert und anschließend dargestellt werden.  

 Im Fenster „Select Visible Waveforms“ kann durch Drücken von Alt und Doppel-Klick ein 

Fenster geöffnet werden, das die Eingabe eines komplexeren Ausdruckes gestattet. Dieser kann 

auch mathematische Verknüpfungen enthalten. Nähere Informationen hierzu sind in der „einge-

bauten“ Hilfe oder im Skript „Einführung in das Simulationsprogramm SPICE“ [3] zu finden.  

 Elegant gelöst ist die Verwendung eines speziellen Cursors in LT-SPICE. Durch Zeigen mit der 

Maus auf eine Leitung verwandelt sich der normale Cursor in einen Spannungs-Cursor (rote 

Prüfspitze) vergleiche Bild 11. Durch Links-Klick wird sofort das Potential der Leitung, d.h. des 

zugehörigen Knotens, dargestellt, z.B. „V(Out)“. Auch in der Statuszeile, ganz unten links, wird 

angezeigt, was geplottet werden kann. – Um eine Potential-Differenz darzustellen, kann eine Re-

ferenz-Markierung gesetzt werden. Dazu wird zunächst, wie oben, der Cursor auf die entspre-

chende Referenz-Leitung gebracht, z.B. Knoten „VCC“. Ausgelöst durch einen Rechts-Klick 

öffnet sich ein kleines Menü, in dem dann „Marc Reference“ ausgewählt wird: Die Markierung 

wird in Form einer schwarzen Prüfspitze sichtbar. Anschließend kann, wieder wie oben, ein 

Spannungs-Cursor gesetzt werden. Durch Links-Klick wird dann sofort das Potential gegenüber 

dem Referenz-Knoten dargestellt. Im Fall des obigen Beispiels erscheint der Plot „V(Out,VCC)“.  

 Eine Potential-Differenz kann auch wie folgt geplottet werden: Mit der Maus auf die Leitung 

(Knoten) zeigen → Links-Klick und gedrückt halten (der Cursor verwandelt sich in einen Span-

nungs-Cursor) → zum Referenz-Knoten führen → Maus-Taste loslassen.  

 Sehr hilfreich ist auch der Strom-Cursor in LT-SPICE, der in Form einer kleinen Stromzange mit 

einem roten Pfeil für die Stromrichtung erscheint, vergl. Bild 11. Wenn der normale Cursor auf 

ein Bauelement zeigt, verwandelt er sich in den Strom-Cursor. Durch einen Links-Klick wird 

dann der Strom durch das betreffende Bauteil geplottet, z.B. „i(R3)“. – Auch zum Plotten von 

Leitungsströmen kann der Strom-Cursor eingesetzt werden: Der normale Cursor  verwandelt sich 

in einen Strom-Cursor, wenn er bei gedrückter Alt -Taste auf eine Leitung geführt wird. Durch 

einen Links-Klick wird die Strom-Darstellung ausgelöst. Auch in der Statuszeile, ganz unten 

links, wird wieder angezeigt, was geplottet werden kann.  

 Konvention: In ein Bauelement hineinfließende Ströme gelten als positiv.  

 Als weitere sehr nützliche Ergänzung bietet LT-SPICE einen Leistungs-Cursor, der es ermög-

licht, die gesamte Leistung eines Bauelementes grafisch darzustellen. Der normale Cursor ver-

wandelt sich in einen Leistungs-Cursor (Thermometer), wenn er bei gedrückter Alt -Taste auf ein 

Bild 11:  Spannungs-Cursor, Referenz-Markierung, 
Strom-Cursor und Leistungs-Cursor  

Spannungs-Cursor (rote Spitze): Auf die Leitung zeigen. 

Referenz-Markierung (schwarze Spitze): Auf die Leitung 
zeigen und Rechts-Klick: → „Mark Reference“.  

Strom-Cursor:  

a) Bauteilstrom: Auf das Bauelement zeigen;  

b) Leitungsstrom: Alt-Taste und auf die Leitung zeigen.  

Leistungs-Cursor (Thermometer): Alt-Taste und auf das 
Bauelement zeigen  
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Bauelement geführt wird, siehe Bild 11. Durch einen Links-Klick wird die Leistungs-

Darstellung ausgelöst. Auch in der Statuszeile, ganz unten links, wird wieder angezeigt, was ge-

plottet werden kann. Wendet man diese Prozedur z.B. auf den Transistor Q1 in Bild 5 an, wird 

folgender Ausdruck grafisch dargestellt: V(Out,5)*Ic(Q1)+V(In,5)*Ib(Q1). Dies ist 

im Fall einer DC-Analyse die gesamte in dem betreffenden Bauelement (hier im Transistor Q1) 

in Wärme umgesetzte Verlustleistung. Bei einer Transienten-Analyse ist die Zeit die unabhängi-

ge Variable (x-Achse). Geplottet wird dann die Leistung als Funktion der Zeit. Die in Wärme 

umgesetzte Verlustleistung ist in diesem Fall der zeitliche Mittelwert der Leistung. Auch dieser 

kann zur Anzeige gebracht werden: Dazu zeigt man bei gedrückter Ctrl -Taste im „Plot-Fenster“, 

siehe Bild 12, mit der Maus auf den Ausdruck (Kurven-Bezeichnung oder trace label), dessen 

Mittelwert gebildet werden soll und führt einen Links-Klick aus. Das Ergebnis wird in einem 

kleinen Fenster angezeigt, vergl. Bild 13. Dieses Fenster enthält neben der Angabe des Mittel-

wertes (in diesem Beispiel den zeitlichen Mittelwert der Leistung, die im Transistors Q1 in 

Wärme umgesetzt wird) auch das zugehörige Zeit-Intervall und das Zeit-Integral der Leistung für 

das Intervall.  

5.3 Operationen im Plot-Fenster  

Durch Links-Klick auf die Titel-Leiste des Plot-Fensters wird dieses aktiviert. Dann bietet LT-SPICE 

mannigfaltige Gestaltungsmöglichkeiten für die Darstellung der Simulationsergebnisse. Das aktive 

Plot-Fenster sei die Ausgangsposition für die Beschreibung der folgenden Arbeitsschritte. Verwendet 

werden wieder Simulationsergebnisse zur Schaltung Bild 5.  

Bild 13:  

Anzeige der Verlustleistung:  

Ctrl drücken und halten →  
im Plot-Fenster auf den  
Ausdruck zeigen.  

 

 

  Bild 12: Aktivierung des Plot-Fensters
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 Drei mögliche Fenster-Anordnungen: Entweder horizontal oder vertikal geteilt oder hinterein-

ander (kaskadenförmig): Mit der Maus auf die „Werkzeug-Leiste“ (Bild 12) gehen → Rechts-

Klick → im sich öffnenden Menü die gewünschte Anordnung auswählen. – Hinweis: Das aktive 

Fenster erscheint als erstes Fenster, also oben bzw. links bzw. vorne.  

 Durch Rechts-Klick in das Plot-Fenster (nicht auf die Titel-Leiste des Plot-Fensters) öffnet sich 

ein „Werkzeug-Menü“, siehe Bild 14 a). Einige Werkzeuge sind bereits bekannt oder brauchen 

nicht weiter erklärt zu werden. Kurz erläutert werden sollen jedoch drei wichtige Werkzeuge:  

1) Add Plot Pane öffnet einen weiteren Plot-Bereich. Dies kann auch einfacher über einen 

Shortcut erreicht werden: Im aktiven Plot-Fenster den Shortcut Ctrl A eingeben. Das Einrich-

ten von Shortcuts wird im Abschnitt 8.5 beschrieben.  

2) Add Trace: Dialogfeld zur Auswahl darzustellender Kurven. Dieses ist vergleichbar mit 

dem bereits bekannten Menü „Kurve auswählen“ (siehe Bild 8). Es bietet aber drei interes-

sante Möglichkeiten. Erstens existiert ganz oben ein kleines Feld, in das Kürzel hineinge-

schrieben werden können. Dadurch kann die Auswahl an darzustellenden Kurven im Dialog-

feld eingeschränkt werden. Wird z.B. ein „i“ eingetippt, werden nur Ströme angezeigt. Zwei-

tens ist das Feld zum Formulieren von Verknüpfungen und mathematischen Ausdrücken et-

was einfacher zu handhaben. Drittens kann ein Shortcut zum Öffnen des Dialogfeldes defi-

niert werden. Es reicht dann aus, bei aktivem Plot-Fenster einfach den Shortcut A einzutip-

pen. Das Einrichten von Shortcuts wird im Abschnitt 8.5 beschrieben.  

3) Sync. Horiz. Axes: Werden zwei Plots in getrennten Feldern dargestellt, haben normaler-

weise beide dieselbe x-Variable. Nach Links-Klick auf die Schaltfläche Sync. Horiz. Axes 

besteht die Möglichkeit, unterschiedliche Variablen zu wählen, Beispiel: Abschnitt 7.2.  

 In der Werkzeugleiste (Bild 12) kann der Menü-Punkt „Plot Settings“ ausgewählt werden. Es 

öffnet sich ein Dialogfeld mit weiteren Werkzeugen, siehe Bild 14 b). Die meisten Werkzeuge 

Bild 14: Zwei Werkzeug-Menüs für den Plot-Bereich  

a) Rechts-Klick direkt im „Plot-Fenster“ (nicht in der „Titel-Leiste“)  

b) „Plot Settings“ in der „Werkzeug-Leiste“ anklicken (siehe z.B. Bild 12)  
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sind in dem zuvor genannten Werkzeug-Menü enthalten. Vier zusätzliche Werkzeuge sollen kurz 

erläutert werden:  

1) Notes & Annotations: Für zusätzliche Beschriftungen, Pfeile usw.  

2) Save Plot Settings: Es besteht die Möglichkeit, die Plot-Einstellungen zu speichern. Die 

Einstellungen werden als Text-File mit der Endung .plt gespeichert.  

3) Open Plot Setting File: Es besteht die Möglichkeit, aus bereits gespeicherten Plot-Settings 

eins auszuwählen. Dies kann auch einfacher über einen Shortcut erreicht werden: Im aktiven 

Plot-Fenster den Shortcut P eingeben; Das Einrichten wird in Abschnitt 8.5 beschrieben.  

4) Reload Plot Settings: Ein für eine Simulation gespeichertes Plot-Setting-File wird geladen. 

Die Plots erscheinen mit den gespeicherten Einstellungen. Auch dies kann einfacher über ei-

nen Shortcut erreicht werden: Im aktiven Plot-Fenster den Shortcut Y eingeben; Das Einrich-

ten wird in Abschnitt 8.5 beschrieben.  

 Ausschnitts-Vergrößerung: Eine Ausschnitts-Vergrößerung kann einfach 

durch Zeichnen eines Rechtecks um den gewünschten Bereich erreicht wer-

den. Zuvor muss dazu das Werkzeug Zoom Area ausgewählt werden. Durch 

View Fit kann das Bild wieder im Ganzen dargestellt werden.  

 Die Limits der beiden Achsen können auch ganz gezielt eingestellt werden. 

Durch Zeigen mit der Maus auf eine Achsen-Beschriftung verwandelt sich der Cursor in ein 

kleines Lineal. Ein Links-Klick führt dann zum Öffnen eines Dialogfeldes, in das die Achsen-

Limits eingetragen werden können. Für die horizontale Achse kann darüber hinaus die Variable 

geändert werden. Die neue Variable darf auch algebraische Verknüpfungen enthalten. 

 Abtasten einer Kurve mit dem Maus-Cursor: Führt man die Maus im Plot-Fenster über eine 

dargestellte Kurve, können in der LT-SPICE-Statuszeile (ganz unten links) die Koordinaten ab-

gelesen werden.  

 Angehefteter Cursor: Zum genauen Vermessen einer Kurve kann an sie ein Cursor angeheftet 

werden, der in Form zweier sich kreuzenden Linien erscheint. Durch einen Links-Klick auf die 

„Kurven-Bezeichnung“ (trace label) wird der Vorgang ausgelöst. Der Label wird zur Markierung 

gestrichelt umrandet, und es öffnet sich ein Fenster, das die x- und y-Werte anzeigt. Beim Zeigen 

mit der Maus auf eine der Cursor-Linien verwandelt sich der Cursor in eine gelb ausgefüllte „ “. 

Nach dem Drücken der linken Maus-Taste können die Linien bewegt werden.  

 Zweiter Cursor: Der gerade genannte Cursor kann durch einen zweiten ergänzt werden. Durch 

Rechts-Klick auf die „Kurven-Bezeichnung“ (trace label) wird der sogenannte „Expression-

Editor“ geöffnet. Er gestattet einerseits eine weitreichende algebraische Formulierung eines dar-

zustellenden Plots. Andererseits gelingt über das Feld Attached Cursor das Einblenden eines 

zweiten Cursors, siehe Bild 15. Jeder Cursor kann unabhängig mit der Maus verschoben werden. 

Dadurch besteht die Möglichkeit, Differenzen zu messen. Dies ist z.B. in Bild 16 für den Plot 

V(Out) (Schaltung Bild 5) gezeigt. Das sich öffnende Fenster zeigt die Werte der horizontalen 

 
Bild 15: Expression-Editor  

Rechts-Klick auf eine „Kurven-
Bezeichnung“ im Plot-Fenster 
öffnet diesen Editor 
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und der vertikalen Achsen, sowie die zugehörigen Differenzen. Die unterste Zeile enthält noch 

zwei weitere nützliche Informationen: Der erste Wert ist der Kehrwert der horizontalen Diffe-

renz. Er erscheint in diesem Beispiel mit der Einheit „kHz“. Es besteht somit die Möglichkeit, die 

Frequenz einer Schwingung zu messen. Der zweite Wert in der untersten Zeile gibt den Diffe-

renzen-Quotienten (Slope) an. Er gibt Aufschluss über die Steigung der Kurve.  

 Wird ein zweiter Cursor verwendet, kann dieser auch an eine andere Kurve geheftet werden.  

 Kurvenschar: Nach einer Step-Anweisung wird eine Kurvenschar dargestellt. Die einzelnen 

Kurven erscheinen in unterschiedlichen Farben. Den Hinweis, welche Kurve zu welchem Para-

meter gehört, erhält man über eine angeheftete Cursor-Linie: Cursor durch Links-Klick auf die 

„Kurven-Bezeichnung“ (trace label) → mit dem Maus-Cursor auf die Cursor-Linie zeigen (gelb 

hinterlegte Ziffer wird sichtbar), → Rechts-Klick → die „Cursor Step Information“ erscheint.  

 AC-Analyse:  Die Schaltung Bild 5 soll z.B. im Frequenzbereich 10 Hz … 100 MHz untersucht 

werden. Die Analyse-Anweisung lautet dann: .AC dec 50 10Hz 100Meg.  

 Tip: Um ohne große Umschweife gleich die Übertragungsfunktion (Ausgangsgröße dividiert 

durch Eingangsgröße) zu erhalten, sollte die Eingangsgröße auf  AC 1V  bzw. AC 1A  eingestellt 

werden. Dann wird durch „1“ dividiert. Wegen der Linearisierung sämtlicher Bauelemente für 

deren Arbeitspunkte braucht man sich um Übersteuerungen keine Gedanken zu machen.  

 Im Fall einer AC-Analyse wird normalerweise gleich der Bode-Plot dargestellt: Der Amplitu-

dengang in Dezibel und die Phase in Grad. Beide Kurven erscheinen im selben Diagramm; links 

die Achsen-Beschriftung für die Amplitude, rechts für die Phase. – Getrennte Ansichten sind ein-

fach durch Öffnen eines zweiten Plot-Fensters möglich, zunächst mit demselben Inhalt. Ein 

Links-Klick auf die rechte Achse führt zum Öffnen eines Dialogfeldes, in das einerseits die Ach-

sen-Limits eingetragen werden können, das aber andererseits auch die Möglichkeit bietet, das 

Bild 16: Erster und zweiter Cursor im Plot-Bereich  

Rechts-Klick auf die „Kurven-Bezeichnung“ → 1st & 2nd Cursor → Cursor verschieben.  
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Plotten der Phase auszuschalten: Don’t plot phase. Ein analoges Dialogfeld öffnet sich beim 

Links-Klick auf die rechte Achse. Es erlaubt das Ausschalten des Amplitudenganges durch Betä-

tigen der Schaltfläche Don’t plot magnitude, siehe Bild 17.  

 Ortskurven-Darstellung: Im Fall einer AC-Analyse kann das Simulationsergebnis auch in 

Form einer Ortskurve dargestellt werden: Realteil = x-Achse, Imaginärteil = y-Achse. Dazu wird 

der y-Achsen-Editor (siehe Bild 17) durch Links-Klick auf die linke-y-Achse geöffnet. Im Menü 

Representation wird wird Nyquist ausgewählt.  

5.4 Einbinden mathematischer Operationen 

LT-SPICE bietet die Möglichkeit, Simulationsergebnisse in mannigfacher Weise miteinander zu ver-

knüpfen und auch mathematische Ausdrücke einzubinden. Die Vorgehensweise:  

 Rechts-Klick direkt im „Plot-Fenster“ (nicht in der „Titel-Leiste“) → Add Trace (oder einfa-

cher: Shortcut A) → im sich öffnenden Dialogfeld kann in der unteren Kommando-Zeile der ge-

wünschte Ausdruck eingetragen (es ist nur eine Zeile möglich).  

 Rechts-Klick auf eine „Kurven-Bezeichnung“ (trace label) öffnet den sogenannten „Expression-

Editor“, siehe Bild 15. Dieses Dialogfeld bietet Raum für mehrzeilige darzustellende Ausdrücke. 

Eine neue Zeile wird durch Ctrl M eingeleitet.  

 Mögliche Operationen: Siehe Help (Shortcut F1) → Help Topics → Inhalt → LTspice IV → 

Waveform Viewer → Wafeform Arithmetic.  

 Eigene Funktionen: LT-SPICE bietet auch die Möglichkeit, eigene Funktionen zu definieren. 

Nähere Informationen sind in der LT-SPICE-Hilfe zu finden: Hilfe → Help Topics → Inhalt → 

LTspice IV → LTspice → Dot Commands → .FUNC; siehe auch [3] und [9].  

5.5 FFT-Plot  

Im Anschluss an eine Transienten-Analyse gestattet LT-SPICE die grafische Darstellung einer periodi-

schen Funktion in Form eines Frequenz-Spektrums (FFT-Plot = Fast-Fourier-Transformation). Hierfür 

sind allerdings unbedingt einige Vorüberlegungen notwendig, damit nicht Frequenzlinien vorgetäuscht 

werden, die in Wahrheit nicht auftreten. So erfordert die FFT-Darstellung eine detaillierte Angabe der 

Transienten-Anweisung. Allgemeine Syntax:  

.TRAN  Tstep  Tstop  [Tstart [dTmax]] 

Hierin gibt  Tstop  den Analyse-Zeitraum an. Die Zeitangabe  Tstep  spezifiziert  das Druck- oder 

Plot-Intervall für Zeilendrucker und hat heute eigentlich keine Bedeutung mehr. Der Default-Wert ist 

deshalb bei LT-SPICE  Tstep = 0. Die optionalen Angaben  Tstart und  dTmax werden für die 

FFT-Darstellung sehr wichtig:  Mit  Tstart werden die Ergebnisse bis zu diesem Zeitpunkt unter-

drückt. Mit der Angabe von  dTmax kann die maximale Zeit-Schrittweite vorgegeben werden. Die 

wahre Schrittweite wird vom Programm automatisch an die Rechenaktivität angepasst. Standardmäßig 

ist dTmax = Tstop/50. Ein  kleinerer  Wert  dTmax  führt zu „glatteren“ Kurven, verlängert aber 

 

Bild 17: y-Achsen-Editor  

Links-Klick auf die linke y-
Achse öffnet diesen Editor    
(im Fall einer AC-Analyse) 
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die Rechenzeit. Die Parameter der Transienten-Anweisung müssen für einen aussagekräftigen FFT-

Plot sorgfältig überlegt werden:  

 Der Darstellungszeitraum (Tstop – Tstart) muss unbedingt über ganzzahlige Vielfache der 

Periodendauer des Signals erstreckt werden. Tstart hängt von Einschwingvorgängen ab.  

 Der Zeitraum (Tstop – Tstart) bestimmt sowohl die Breite der Linien als auch die Start-

frequenz des Spektrums. Das gilt auch für den minimalen Frequenzschritt: 

2 1
; .Linienbreite Startfrequenz Frequenzschrittweite

Tstop Tstart Tstop Tstart
  

 
 

 Der maximale Zeitschritt dTmax kann als Kehrwert der minimalen Samplefrequenz fs,min ge-

deutet werden, und diese Frequenz muss entsprechend der Shannon-Bedingung mindestens dop-

pelt, besser 20× so hoch sein [6], wie die höchste im Signal erwartete Oberwellenfrequenz fmax:  

 
 

max,min
max,min

1 1 1
2... 20     .

2 ... 20s
s

f f dTmax
dTmax f f

     


 

dTmax ist der maximal vorgegebene Zeitschritt. Die tatsächliche Schrittweite wird vom Simula-

tor automatisch den Erfordernissen angepasst und kann deshalb kleiner ausfallen, d.h. die tat-

sächliche Samplefrequenz fs ist meist höher als fs,min und auch nicht konstant.  

 Die Zahl der Samples für den FFT-Plot ergibt sich aus dem Zeitraum (Tstop – Tstart) und 

der Samplefrequenz fs. Wäre fs konstant, könnte die Samplezahl wie folgt angegeben werden.  

 - .SSamplezahl Samplefrequenz Analyse Zeitraum f Tstop Tstart      

Nun ist aber die Samplefrequenz fs in der Regel größer als fs,min = 1/dTmax. Folglich gilt:  

 ,min
.

 maxs
Darstellungszeitraum Tstop Tstart

Samplezahl f Tstop Tstart
maximaler Zeitschritt dT


      

Für die Darstellung eines FFT-Plots wird die Samplezahl (Number of data samples in time) in 

Form einer Zweierpotenz 2
N 

 (512, 1024,  …) verwendet und muss angegeben werden (siehe spä-

ter). Eine hohe Samplezahl vergrößert zwar den Dynamikbereich der Amplitudendarstellung, 

doch ist es nicht sinnvoll, mehr Samples vorzugeben, als tatsächlich während der Transienten-

Analyse ermittelt wurden. Unerwünschte Details im Spektrum wären die Folge. Meist reicht es 

aus, sich an der höchsten im Spektrum erwarteten Oberwellenfrequenz fmax zu orientieren:  

 max2 2 .Ngewählte Samplezahl f Tstop Tstart      

 Außerdem ist zu beachten, dass für die Speicherung des Ergebnis-Files (RAW-Datei) normaler-

weise eine beträchtliche Datenkompression vorgenommen wird. Die FFT-Darstellung wird da-

durch deutlich verschlechtert. Durch die Options-Anweisung: .Options Plotwinsize = 0 

kann die Datenkompression jedoch einfach ausgeschaltet werden.  

Für unsere Schaltung Bild 5 soll nun ein FFT-Plot erstellt werden. Interessant sei der Frequenzbereich 

von etwa 1 kHz bis 100 kHz, und die Linienbreite möge z.B. 1 kHz betragen. Ein Darstellungszeitraum 

von (Tstop – Tstart) = 2/Linienbreite = 2/(1 kHz)  = 2 ms reicht somit aus. Dieser Wert ist 

ein ganzes Vielfaches der Signal-Periode. Einschwingvorgänge sollten bis Tstart = 100 ms abge-

klungen sein. – Die Darstellung des Spektrum bis zu einer Frequenz von fmax = 100 kHz erfordert eine 

Samplefrequenz von mindestens 200 kHz. Als maximaler Zeitschritt dTmax  würde dann ein Wert von 

5 µs gerade ausreichen. Mit dTmax = 0.5 µs wird jedoch eine höhere Genauigkeit erzielt. – Als Sam-

plezahl (Number of data samples in time) genügt ein Wert von 2 ∙ fmax ∙ (Tstop – Tstart) = 400. 

Da aber die Zahl der echten Samples wegen dTmax = 0.5 µs höher ist als erforderlich, kann problem-
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los die nächst höhere Zweierpotenz 512 = 2
9
, N = 9 oder sogar 1024 = 2

10
, N = 10 eingesetzt werden. – 

Nun zur Simulation der Schaltung Bild 5:  

 Transienten-Anweisung ändern in: .TRAN 0us 102ms 100ms 0.5us.  

(Tstop – Tstart = 102 ms – 100 ms = 2 ms) 

 Simulation starten.  

 Das Plot-Fenster durch Links-Klick auf dessen Titel-Leiste aktivieren.  

 FFT-Darstellung aktivieren: View → FFT, siehe Bild 18. Anschließend im sich öffnenden Fen-

ster Select Waveforms to include in FFT die gewünschten Kurven auswählen → Number of 
data samples: 1024. Das Spektrum für die Ausgangsspannung am Knoten „6“ zeigt Bild 19.  

 Achtung: Die Ergebnisse werden als Effektiv-Werte dargestellt!  

 Fourier-Komponenten: Die Amplituden der Harmonischen können auch als Fourier-

Komponenten in Tabellenform ausgegeben werden. Dazu ist in der Schaltung bzw. Circuit-Datei 

eine entsprechende Zeile hinzuzufügen:  

.Four f1 [Zahl der Harmonischen] Ausgangswert1 Ausgangswert2 ...  

Mit  Ausgangswert1, Ausgangswert2, . . .  werden die Schwingungen (Knotenspannungen 

oder Bauteilströme) ausgewählt, für die eine Fourier-Analyse durchzuführen ist. Die Frequenz  

f1  kennzeichnet die Grundfrequenz der periodischen Schwingung. Optional kann die Zahl der 

 

Bild 18: FFT aktivieren  

 

 

Bild 19: FFT-Plot zur Schaltung Bild 5 (SPICE-Datei: Bild 5_FFT.asc) Ausgangsknoten „6“  

Öffnen der Achsen-Editoren durch Links-Klick auf die Achsen, Editor vergl. Bild 17. 
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zu berechnenden Harmonischen angegeben werden; der Default-Wert ist 9. Ermittelt wird auch 

der DC-Anteil. Der Berechnung der Fourier-Koeffizienten eines periodischen Signals wird 

rechtsbündig genau die letzte Periode (Kehrwert der Grundfrequenz f1) zugrundegelegt. Der 

Zeitbereich muss deshalb nicht über ganzzahlige Periodenlängen erstreckt werden.  

 In unserem Beispiel soll die Ausgangsspannung V(6) analysiert werden, und wir wollen uns auf 

die ersten fünf Harmonischen beschränken: .Four 10kHz 5 V(6).  

 Das Ergebnis wird nach erfolgter Transienten-Analyse ins Error-Log-File geschrieben. Es kann 

durch View → SPICE Error Log sichtbar gemacht werden, vergl. Bild 20.  

 Die Log-Datei ist normalerweise nicht permanent. Sie kann aber auf  zweierlei Weise gespeichert 

werden. Entweder: alles Markieren → Ctrl C (in die Zwischenablage kopieren) und dann als 

Text-Dokument speichern (z.B. mit der Endung .txt).  Oder:  Tools → Control Panel →  

Operation → Automatically delete .log files → No. Diese letzte Methode führt aber im Laufe 

der Zeit zu viel Daten-Müll!  

5.6 Einstellen der Betriebstemperatur  

1. Globale Vorgabe einer Temperatur  

Wenn im Schaltplan keine Betriebstemperatur angegeben wird, rechnet LT-SPICE automatisch mit 

dem Default-Wert Temp = 27 °C (entsprechend T = 300 K). Andere Werte, einzelne oder auch mehrere, 

können einfach durch die SPICE-Zeile  

.Temp <Temp1> <Temp2> ...  

oder auch durch die Step-Anweisung  

.Step Temp List <Temp1> <Temp2> ...  

vorgegeben werden. Sie gelten dann für alle Bauelemente der Schaltung, also global.  

In LT-SPICE kann auch ein Temperatursweep mittels einer DC-Anweisung durchgeführt werden. Dies 

ist z.B. für die Ergebnisdarstellung in Abhängigkeit von der Temperatur sehr hilfreich. Beispiel:  

.DC Temp -25 125 1   

Dies bedeutet eine Variation von – 25 °C bis 125 °C in 1-Grad-Schritten. Im Plot erscheint dann die 

Temperatur als Abszisse (x-Achse). Auch hier gilt die Temperatur für alle Elemente.  

 

Bild 20: Ergebnis einer Fourier-Analyse (Simulationsdatei: Bild 5_FFT.asc)
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2. Individuelle Vorgabe der Temperatur für einzelne Bauelemente  

Über die im Punkt 1. genannten Anweisungen wird die Temperatur global eingestellt, d.h. sie gilt für 

alle Elemente einer Schaltung in gleicher Weise. In vielen Anwendungen können aber einzelne Bautei-

le unterschiedliche Temperaturen annehmen, z.B. durch Eigenerwärmung infolge erhöhter Verlustleis-

tung. In solchen Fällen führt eine globale Vorgabe der Temperatur verständlicherweise zu ungenauen 

Simulationsergebnissen. Sehr viel sinnvoller ist es dann, einzelnen Bauteilen eine individuelle Be-

triebstemperatur zuzuweisen. Dies ist in LT-SPICE problemlos möglich; dem entsprechenden Element 

wird einfach die Temperatur als Attribut in der Form Temp = <Wert> mitgegeben. Hierzu ein Bei-

spiel: Ein Projekt oder eine Schaltung, Schaltungsausschnitt siehe Bild 21, soll für eine Betriebstempe-

ratur von 35 °C untersucht werden, der Transistor Q2 möge aber wegen einer erhöhten Verlustleistung 

im Betrieb eine Temperatur von ca. 48 °C annehmen. Dann wird im Schaltplan zunächst durch die 

SPICE-Zeile  

.Temp 35 (vergl. auch Punkt 1.) 

die globale Temperatur für die gesamte Schaltung angegeben und für den Transistor Q2 das Attribut 

Temp=48 hinzugefügt, das nur dessen Betriebstemperatur auf einen anderen Wert setzt. Diese Me-

thode kann selbstverständlich auch auf weitere Elemente der Schaltung ausgedehnt werden. Auch die 

Zuweisung in Parameterform mit anschließender Step-Anweisung ist möglich. Dies ist in Bild 21 für 

den Transistor Q3 gezeigt. Achtung: die geschweifte Klammer beim Parameter TP darf nicht fehlen!  

5.7 Einbinden von Wave-Dateien 

LT-SPICE bietet neben der Definition normaler unabhängiger Spannungs- und Stromquellen durch 

Gleich- oder Wechselgrößen bzw. Pulsfunktionen auch die Einbindung von Audio-Signalen in Form 

von Wave-Dateien. Eine vorhandene Wave-Datei kann also als Argument oder „Wert“ einer unabhän-

gigen Quelle verwendet werden. Umgekehrt können die Simulationsergebnisse von Transienten-

Analysen auch als Wave-Dateien abgespeichert und dann mit geeigneter Hardware hörbar gemacht 

werden. Zwei Beispiele sollen dies verdeutlichen. Zu diesem Zweck wird ein zweiter Projektordner im 

Ordner Schematic angelegt. Er erhält den Namen Projekt_2.  

1.   Wave-Datei als Argument einer unabhängigen Spannungsquelle 

 In den neuen Unterordner Projekt_2 im Ordner Schematic kopieren wir eine beliebige 

auf dem Rechner vorhandene Wave-Datei, z.B. die Datei „ding.wav“ aus dem Windows-

Ordner (Pfad bei Windows XP: C:\Windows\Media\ding.wav; oder es kann auch durch 

eine Suchroutine eine beliebige andere Datei mit der Endung .wav gefunden werden).  

  

Bild 21:  

Vorgabe individueller Bauteiltem-
peraturen  

Attribut bei Q2: Temp = 48  

Attribut bei Q3: Temp = {TP}  

.Param TP = 50  

setzt TP zunächst auf 50 °C. 
Durch die Step-Anweisung  

.Step Param TP List 35 50 65  

wird der Wert 50 °C wieder über-
schrieben.  
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 Im Ordner Projekt_2 legen wir dann eine Schaltung an, die z.B. den Namen Wave-1.asc 

erhalten soll; Pfad:  D:\Schematic\Projekt_2\Wave-1.asc. Später kann dann einfach 

mittels des Windows-Befehls Ctrl S gespeichert werden, weil der Pfad bereits festliegt.  

 Einfügen einer Spannungsquelle entsprechend Bild 22. Als „Wert“ der Spannungsquelle wird 

einfach der Pfad der Wave-Datei eingetragen: wavefile = Pfad der Wave-Datei [chan = <nnn>]. 

Bis zu 65536 Kanäle (0 bis 65535) können angewiesen werden. Chan = 0 bedeutet meist „linker 

Kanal“ und chan = 1 „rechter Kanal“. Siehe hierzu auch Hilfe → LTspice IV → LTspice → 
Circuit Elements → V. Voltage Source.  

 Eintragen der Anweisung für eine Transienten-Analyse, hier z.B. .Tran 1s.  

 Simulation starten und Darstellung der Spannung am Knoten „A“; siehe Bild 23.   

2.   Wave-Datei in LT-SPICE erzeugen  

Das Ergebnis einer Transienten-Analyse kann als Wave-Datei abgespeichert und diese anschließend 

auch hörbar gemacht werden. Das folgende Beispiel soll dies veranschaulichen.  

 Im Ordner Projekt_2 legen wir eine weitere Schaltung an, die den Namen Wave-2.asc er-

hält. Das Signal soll z.B. als Produkt der drei Spannungen V1, V2 und V3 entstehen: Bild 24. 

  

Bild 22:  

Einbindung einer Wave-Datei 
als Argument einer unabhängi-
gen Spannungsquelle  
 

 

Bild 23: Ausgangssignal der Spannungsquelle entsprechend Bild 28  
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Dabei kann V3 als „Fenster-Funktion“ zum Ein- und Ausblenden des Signals V1*V2 angesehen 

werden. Die Spannung, die am Knoten „D“ mit Hilfe der B-Quelle B1 gebildet wird, soll schließ-

lich als Wave-Datei gespeichert werden. Maximaler Betrag: 1 V (bzw. 1 A bei Stromquellen)! 

 Mit der Anweisung .Wave <filename.wav> <Nbits> <SampleRate> V(out) 

[V(out2) ...]  wird SPICE dazu veranlasst, die Wave-Datei zu bilden. Siehe auch Hilfe → 

LTspice IV → LTspice → Dot Commands → .WAVE.   

 Nach dem Starten der Simulation wird die Spannung für den Knoten „D“ berechnet (vergleiche 

Bild 25) und gleichzeitig die Wave-Datei mit dem Namen „V(D).wav“ im durch die .Wav-

Anweisung angegebenen Ordner gespeichert. Diese kann dann hörbar gemacht werden.  

5.8 Laplace-Übertragungsfunktion  

Übertragungsfunktionen von Vierpolen können auch durch die Laplace-Form im Argument einer ge-

steuerten E-Quelle als „Wert“ dieser Quelle beschrieben werden. Wir wollen uns dies am Beispiel der 

Schaltung „TwoTau.asc“ aus dem Education-Ordner von LT-SPICE ansehen. Pfad der Datei:  

C:\LTC\LTspiceIV\Examples\Educational\TwoTau.asc  

Diese Datei kopieren wir in den Ordner Projekt_2 und ändern sie geringfügig ab, siehe Bild 26. Die 

Schaltung enthält zwei RC-Glieder R1, C1 und R2, C2; sie bilden einen Tiefpass zweiter Ordnung. Als 

Eingangssignal dient das Rechteck-Signal der Spannungsquelle V1. Der Ausgangsknoten ist „A“.  

 

Bild 25: Spannung, die am Knoten „D“ gebildet und als Wave-Datei gespeichert wird  

 

Bild 26: Schaltung „TwoTau“ aus dem Education-Ordner von LT-SPICE als Bei-
spiel für die Laplace-Darstellung eines Vierpols mit zwei Polstellen  
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Vom Eingangssignal V1 wird auch die spannungsgesteuerte Spannungsquelle E2 angesteuert. Diese 

enthält die Laplace-Form der Übertragungsfunktion als „Steuergröße“. Ausgangsknoten ist „B“.  

Ein dritter „Vierpol“ mit prinzipiell demselben Frequenzverhalten, also mit denselben Zeitkonstanten 

die der Original-Tiefpass hat, wird ebenfalls vom Eingangssignal V1 angesteuert: die spannungsge-

steuerte Spannungsquelle E1. Der Zähler-Term „exp(-2m*s)“ bewirkt eine Verzögerung des Aus-

gangssignals um etwa 2 ms. Hier ist „C“ der Ausgangsknoten, siehe Bild 26.  

In diesem Beispiel sind die beiden Zeitkonstanten gleich groß: R1*C1 = R2*C2 = 1 ms. Wegen des um 

den Faktor 1000 größeren Widerstandes R2 gegenüber R1 belastet das zweite RC-Glied R2, C2 den 

Knoten „2“ praktisch nicht, sodass in der Laplace-Darstellung näherungsweise nur eine „doppelte“ 

Polstelle auftritt.  

5.9 Kommandos zu Analysen bzw. Auswertungen von Analysen  

Neben den bisher genannten Anweisungen bietet LT-SPICE eine ganze Reihe weiterer Kommandos zu 

Analysen bzw. Auswertungen von Analysen, die hier nicht alle angesprochen werden können. Sie sind 

aber in der Hilfe gut dokumentiert:  

Help (F1) → Help Topics → Inhalt → LTspice IV → LTspice → Dot Commands.  

Bitte schauen Sie sich die verschiedenen Kommandos, die sogenannten „Dot Commands“, einmal nä-

her an. Sie geben nämlich einen guten Überblick über die vielfältigen Möglichkeiten des Simulators 

LT-SPICE. Neben den in diesem Skript bereits verwendeten Analyse-Anweisungen möchte ich Ihnen 

die folgenden Direktiven besonders ans Herz legen:  

.Noise, .TF, .Options, .Global, .Func, .Measure, .Net, .Save, und die Paare .IC und 

.Nodeset, .SaveBias und .LoadBias, .Model und .Subckt, .Lib und .Include, sowie 

.End und .EndS.  

6 Zeichnen von Symbolen  

Symbole für die Schaltbilder werden normalerweise im Sym-Ordner von LT-SPICE gespeichert. Pfad: 

C:\LTC\LTspiceIV\lib\sym\. In diesem Ordner können auch selbsterstellte Symbole gesam-

melt werden. Wie solche erstellt werden, soll in den folgenden Abschnitten kurz erläutert werden. LT-

SPICE enthält dazu ein spezielles Zeichenprogramm.  

 Symbol-Zeichenprogramm öffnen durch File → New Symbol.  

 Im sich öffnenden Zeichenfenster kann nun das neue Symbol gezeichnet werden. Dazu stehen im 

Menü Draw die wichtigsten Werkzeuge wie z.B. „Linie“, „Rechteck“ usw. zur Verfügung, ver-

gleiche Bild 28. Diese Objekte sind nicht elektrisch relevant, sondern dienen nur der optischen 

Gestaltung. Die Endpunkte sind durch kleine rote Kreise gekennzeichnet; diese Markierungen 

sind später im Schaltbild nicht sichtbar.  

 

Bild 27:  

Ausgangsspannungen 
an den Knoten „A“, „B“ 
und „C“. Die Spannun-
gen V(A) und V(B) fal-
len praktisch zusam-
men.  
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 Durch „Pins“ oder „Ports“ werden die elektrischen Verbindungen zum Symbol hergestellt. Sie 

werden durch das Kommando Edit → Add Pin/Port hinzugefügt. Im sich öffnenden Dialogfeld 

sind zwei wichtige Eintragungen vorzunehmen: erstens im Feld Label der Knoten- oder Pin-

Name und zweitens im Feld Netlist Order die Reihenfolge, mit der der Knoten später in der 

SPICE-Netzliste erscheinen soll. Die Reihenfolge muss unbedingt mit der des zugehörigen 

SPICE-Modells oder der in einer Bibliothek gespeicherten Subcircuit-Definition übereinstim-

men. Der Knoten-Name (Label) hat dagegen nur dann eine wichtige Bedeutung, wenn das Sym-

bol in einer hierarchischen Schaltung verwendet wird und dahinter eine Schaltung gleichen 

Namens, aber mit der Endung .asc steht, siehe Kapitel 7.  

 Attribute werden über das Kommando Edit → Attributes → Edit Attributes definiert. Das 

wichtigste Attribut ist der charakteristische Kennbuchstabe (z.B. „R“ für einen Widerstand, „Q“ 

für einen bipolaren Transistor oder „X“ für eine Subcircuit usw.). Nähere Informationen sind zu 

finden unter: Hilfe → Inhalt → Schematic Capture → Creating New Symbols.  

 Im Attribut-Editor kann angegeben werden, ob das Symbol als Cell oder als Block gebraucht 

werden soll. Wenn das dahinter stehende SPICE-Modell oder die Subcircuit-Definition in einer 

Bibliothek gespeichert ist, ist der Symbol-Typ Cell geeignet. Für den Gebrauch in hierarchischen 

Schaltungen, siehe Kapitel 7, wird dagegen der Symbol-Typ Block gewählt.  

 Speichern des neuen Symbols in der LT-SPICE-Symbol-Bibliothek (Endung .asy); Pfad: 

C:\LTC\LTspiceIV\lib\sym\ oder dort in einem speziellen Ordner, in dem eigene Sym-

bole gesammelt werden.  

 Oft ist es möglich, ein bereits in der Symbol-Bibliothek vorhandenes Symbol zu editieren, abzu-

ändern und unter dem neuen Namen zu speichern.  

7 Hierarchische Schaltpläne  

Hierarchische Schaltungen haben den großen Vorteil, komplexe Schaltungen übersichtlich in Form ei-

nes Blockschaltbildes auf einer Seite darstellen zu können. LT-SPICE bietet darüber hinaus die kom-

fortable Möglichkeit, die hinter einem Block-Symbol stehende Schaltung einfach durch einen Doppel-

Klick auf das Symbol zu öffnen.  

 

 Bild 28: Zeichnen eines neuen Symbols 
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7.1 Zeichnen eines hierarchischen Schaltplanes  

Das Zeichnen eines hierarchischen Schaltplanes ist in LT-SPICE relativ einfach. Die wichtigsten Re-

geln und Schritte werden im Folgenden kurz erläutert:  

 Es ist sinnvoll, im normalen Schaltungs-Ordner  Schematic  (siehe Abschnitt 2.1) einen Pro-

jekt-Ordner anzulegen, in dem alle Einzel-Dateien übersichtlich zusammengefasst werden.  

 Zu jedem Schaltungs-Block eines hierarchischen Schaltplans wird mit dem Schematic-Capture-

Werkzeug von LT-SPICE ein Schaltbild erstellt. Dieses muss im Projekt-Ordner gespeichert 

werden, in dem auch die Hauptschaltung steht. Die Endung ist .asc.  

 Zu jedem Schaltungs-Block wird ein Block-Symbol (nicht Cell) erstellt. Sämtliche Attribute 

werden gelöscht. Es muss genau denselben Namen erhalten, wie der dahinter stehende Schalt-

plan, nur mit anderer Datei-Endung: .asy. Auch das Symbol muss im Ordner der Hauptschal-

tung gespeichert werden.  

 Die Zahl der Anschluss-Pins von Symbol und zugehörigem Schaltplan muss übereinstimmen.  

 Die Namen der Anschluss-Pins von Symbol und Schaltplan müssen übereinstimmen.  

 Wenn die oben genannten Regeln beachtet werden, kann in der Hauptschaltung durch einen 

Doppel-Klick auf ein Block-Symbol die dahinterstehende Teilschaltung geöffnet werden. Nach 

einer erfolgten Simulation der Hauptschaltung können auch in einer auf diese Weise geöffneten 

Teilschaltung deren Knoten-Potentiale oder Ströme zur Anzeige gebracht werden.  

Anmerkung: Das „Messen“ innerhalb einer Teilschaltung erfordert allerdings, dass die Optionen 

„Save Subcircuit Node Voltages“ und „Save Subcircuit Device Currents“ aktiviert sind. Dies 

wird über Tools → Control Panel → Save Defaults eingestellt, vergl. auch Kapitel 8.  

 Durch einen Rechts-Klick auf ein Symbol in der Hauptschaltung öffnet sich ein spezielles Dia-

logfeld, der sogenannte Block-Navigator, siehe Bild 29. Über die Schaltfläche Open Symbol 

kann das Symbol geöffnet werden. Auch die zugehörige Schaltung ist in diesem Dialogfeld über 

eine Schaltfläche zu erreichen. Es reicht aber auch ein Doppel-Klick auf das Symbol.  

7.2 Beispiel  

Ein einfaches Beispiel möge dazu dienen, das Arbeiten mit einer hierarchischen Schaltung noch etwas 

näher zu erläutern. Gewählt wird die in Bild 5 dargestellte Verstärker-Schaltung. Sie wird in Schal-

tungskern und äußere Beschaltung zerlegt. Der Schaltungskern wird dann als Teilschaltung betrachtet 

und in der Hauptschaltung durch ein Symbol ersetzt. Es wird auch gezeigt, wie von der Hauptschaltung 

aus Bauteil-Parameter der Teilschaltung verändert werden können.  

 

Bild 29: Block-Navigator  

Rechts-Klick auf das Block-
Symbol in der Hauptschaltung  
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 Im normalen Schaltungs-Ordner  Schematic  (siehe Abschnitt 2.1) wird ein Projekt-Ordner 

mit dem Namen „Projekt_1“ angelegt, in dem alle Einzel-Dateien übersichtlich zusammengefasst 

werden. Hier gewählter Pfad:  D:\Schematic\Projekt_1.  

 Die Bauelemente um den Transistor Q1 herum bilden den Verstärker-Kern. Hierfür wird ein 

Schaltbild mit dem Namen „Amp1.asc“ erstellt und im Projekt-Ordner „Projekt_1“ gespeichert, 

siehe Bild 30 a).  

 In der Hauptschaltung (Bild 30 b)) kann als Symbol der Teilschaltung das im Kapitel 6 gezeigte 

Beispiel, vergl. Bild 28, verwendet werden. Es hat den Namen „Amp1.asy“ und hat dieselben 

Pin-Namen wie die Schaltung „Amp1.asc“. Dieses Symbol und die Hauptschaltung „Verstär-

ker.asc“ werden im Projekt-Ordner „Projekt_1“ gespeichert.  

 In der Hauptschaltung dürfen die Knoten-Namen um das Symbol herum frei gewählt werden. 

Hier sind z.B. die Knoten-Namen „A“, „B“ und „C“ verwendet worden.  

 Parameter-Übergabe: Auch in hierarchischen Schaltungen können mittels der Parameter-

Anweisung  .Param ...  Parameter über alle Hierarchiestufen hinweg durchgereicht werden. 

In diesem Beispiel soll der Wert des Widerstandes R4 in der Teilschaltung variiert werden kön-

nen. Im Schaltbild „Amp1.asc“ wird deshalb statt eines konkreten Wertes dieser als Parameter in 

geschweiften Klammern angegeben: {R4}. In der Hauptschaltung muss dieser „Wert“ als 

Subcircuit-Parameter im zugehörigen Symbol angewiesen werden. Dies gelingt über den Block-

Navigator, vergleiche Bild 29. Durch einen Rechts-Klick auf das Symbol in der Hauptschaltung 

wird er geöffnet. In der Zeile PARAMS (Subcircuit-Parameter, deshalb das „S“ am Ende) könn-

te der Wert für den Widerstand R4 direkt angegeben werden, z.B.  R4 = 560.  Hier wird aller-

dings erneut ein Parameter, nämlich „R“, verwendet. Deshalb wird die Zeile  R4 = {R}  eingetra-

gen. Im Block-Navigator kann durch ein Häkchen markiert werden (Visible), ob die Einträge im 

 

 Bild 30:  a) Verstärker-Kern: „Amp1.asc“;  b) Hierarchische Schaltung: „Verstärker.asc“  

Der Widerstand R4 der Teilschaltung a) wird in diesem Beispiel in der Hauptschaltung b) über 
die Parameter-Anweisung .Param R = 560  vorgegeben (durch braune Pfeile angedeutet). 
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Schaltbild sichtbar sein sollen oder nicht. In der Hauptschaltung steht schließlich die Anweisung 

.Param R = 560, und durch die Zeile .Step Param R List 390 560 820  wird der 

Widerstandswert entsprechend der durch die Liste spezifizierten Angaben variiert.  

 In einer hierarchischen Schaltung können Potentiale und Ströme in gewohnter Weise geplottet 

werden. Dies gilt auch für Teilschaltungen. In Bild 31 ist z.B. gezeigt, wie das Potential des Kno-

tens „5“ der Teilschaltung dargestellt werden kann: Zuerst wird die Teilschaltung durch einen 

Doppel-Klick auf das Symbol in der Hauptschaltung geöffnet und dadurch das Teilschaltungs-

Fenster aktiviert. Dann kann durch Zeigen auf den Knoten und Links-Klick dessen Potential an-

gezeigt werden: V(X1:5). Im Argument der dargestellten Größe, z.B. des Potentials „V“, wird 

zuerst das Bauteil genannt – hier „X1“ – und nach einem Doppelpunkt der Knoten-Name „5“.  

 

 Bild 31:  Hauptschaltung „Verstärker.asc“ mit Symbol, Teilschaltung und Plot-Fenster.  

In der Teilschaltung „Amp1.asc“ kann z.B. das Potential des Knotens „5“ durch Links-Klick auf 
den Knoten geplottet werden: V(X1:5). Beschriftung: Plot Settings → Notes & Annotations → 
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 Synchronisation der x-Achsen:  Werden zwei Plots in getrennten Feldern dargestellt, haben 

normalerweise beide dieselbe x-Variable. Diese Synchronisation kann ausgeschaltet werden: 

Durch Rechts-Klick in das Plot-Fenster (nicht auf die Titel-Leiste des Plot-Fensters) öffnet sich 

ein „Werkzeug-Menü“, siehe Bild 14 a). Dort kann durch Links-Klick auf das Werkzeug Sync. 
Horiz. Axes das Häkchen weggenommen werden. Anschließend können unterschiedliche Vari-

ablen gewählt werden. Dies soll am Beispiel der Verstärker-Schaltung durch Bild 32 verdeutlicht 

werden:  

Im Plot-Fenster werden zwei Fenster geöffnet (Rechts-Klick im Plot-Fenster → Add Plot Pane 

oder Shortcut Ctrl A). In beiden Fenstern wird z.B. der Kollektor-Strom des Transistors Q1 der 

Teilschaltung dargestellt (IC(X1:Q1)).  

Im nächsten Schritt wird, wie oben schon beschrieben, die Synchronisation der x-Achsen ausge-

schaltet.  

Durch einen Links-Klick auf die x-Achse des oberen Plot-Fensters wird das Dialogfeld Horizon-
tal Axis geöffnet. Im Fenster Quantity Plotted kann anschließend die neue x-Variable eingege-

ben werden: In diesem Beispiel der Basis-Strom des Transistors Q1:  IB(X1:Q1). Nach Bestä-

tigung durch OK wird im oberen Plot-Fenster der Kollektor-Strom in Abhängigkeit vom Basis-

Strom dargestellt. Im unteren Fenster bleibt weiterhin die Zeit (time) die x-Variable. Auch hier 

könnte eine andere Variable gewählt werden.  

Werden z.B. im oberen Plot-Fenster der erste und der zweite Cursor aktiviert, kann aus dem Dif-

ferenzen-Quotienten die Stromverstärkung abgelesen werden: Slope = 190 (vergl. Modell).  

 

 Bild 32:  Zur Ausschaltung der x-Achsen-Synchronisation  
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8 LT-SPICE-Einstellungen (Control Panel)  

Die Grundeinstellungen für LT-SPICE werden über das Dialogfeld  Control 
Panel  vorgenommen. Dieses kann über eine Schaltfläche (als Hammer dar-

gestellt) der Werkzeugleiste geöffnet werden, siehe nebenstehendes Bild. Auf 

eine detaillierte Beschreibung wird hier verzichtet und stattdessen auf die im Programm eingebaute 

Hilfe verwiesen. Die Hilfe-Themen sind über die Schaltfläche Help oder die Funktionstaste  F1 zu er-

reichen. Einzelne Einstellungen sollen im Folgenden dennoch kurz erläutert werden.  

8.1 Operation  

Hier können unter anderem einige Einstellungen vorgenommen werden, die das Speichern von Dateien 

betrifft, die LT-SPICE während der Simulation erzeugt. Es kann angegeben werden, ob solche Dateien 

nach Schließen des Simulators gespeichert werden sollen oder nicht. Damit nicht zu viel Datenmüll 

entsteht, bevorzuge ich das Löschen dieser Dateien.  

Die durch einen Stern (*) gekennzeichneten Einstellungen werden in der LT-SPICE-INI-Datei 

„LTspiceIV.ini“ gespeichert; Pfad: C:\Benutzer\...\LTspiceIV.ini (abhängig vom 

Betriebssystem). Die INI-Datei steht nicht mehr (wie früher) im Windows-Ordner!  

8.2 Compression 

Die Simulationsergebnisse werden als RAW-Daten gespeichert und können im Anschluss an die Simu-

lation durch das Plot-Programm zur Anzeige gebracht werden. Damit die Datenmenge nicht zu groß 

wird, nimmt LT-SPICE eine Kompression vor. Ein komprimiertes File ist etwa fünfzigmal kleiner als 

ein nicht komprimiertes. Im Dialogfeld Compression kann dies näher spezifiziert werden.  

Für viele Anwendungen können die Default-Einstellungen beibehalten werden, doch bei Filter-

Schaltungen hoher Güte oder Quarz-Oszillatoren kann es zu Problemen kommen, wenn zu stark kom-

primiert wird. Dies probiert man am besten aus.  

Die Einstellungen werden nicht in der INI-Datei festgehalten. Man kann allerdings im Schaltplan eine 

Options-Anweisung aufnehmen, die die gewünschten Plot-Einstellungen enthält. Z.B.:  

.Options Plotwinsize = 0 zum Ausschalten der Datenkompression.  

8.3 SPICE  

Es ist ein Kompromiss zu finden zwischen der Rechengenauigkeit und der Rechenzeit. Für viele An-

wendungen können die Default-Einstellungen beibehalten werden, doch in manchen Fällen müssen die 

Toleranzen verringert werden. Dies gilt besonders für Filter-Schaltungen hoher Güte oder Quarz-

Oszillatoren. Hierfür sind oft sogar erheblich höhere Rechengenauigkeiten erforderlich. Dies probiert 

man am besten aus. – Die Einstellungen werden nicht in der INI-Datei festgehalten. Man kann aller-

dings im Schaltplan eine Options-Anweisung aufnehmen, die die gewünschten Genauigkeiten enthält.  

LT-SPICE enthält zwei verschiedene SPICE-Versionen (Solver). Der sogenannte normale Solver ist 

etwa doppelt so schnell wie der alternative (Alternate Solver), hat allerdings eine geringere innere Ge-

nauigkeit. Die gewünschte Version kann in einem Kontrollfeld ausgewählt werden. Diese Einstellung 

wird in der INI-Datei gespeichert. Der verwendete Solver wird in der Statuszeile rechts angezeigt.  

8.4 Save Defaults  

In dieser Registerkarte kann durch ein Häkchen markiert werden, welche Ströme und Spannungen im 

Plot-File (RAW-Datei) gespeichert werden sollen. Je mehr Größen gespeichert werden, desto umfang-

reicher wird die Plot-Datei. Wenn jedoch hierarchische Schaltungen simuliert werden, ist es sinnvoll, 
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auch die Potentiale und Ströme der Subcircuits zu speichern. – Die meisten Einstellungen werden in 

der INI-Datei festgehalten.  

8.5 Drafting Options  

In dieser Registerkarte können Optionen für das Erstellen der Schaltpläne definiert werden. Hier wer-

den z.B. auch die Farben und Buchstaben-Größen festgelegt. – Die meisten Einstellungen werden in 

der INI-Datei gespeichert.  

 Farb-Einstellungen können nach Betätigen der Schaltfläche Color Schema sowohl für die 

Schaltungen, als auch für den Plot-Bereich und die Netzlisten vorgenommen werden, vergleiche 

Bild 33. Auch die Hintergrund-Farbe wird hier eingestellt. Ein weißer Hintergrund ist z.B. dann 

sinnvoll, wenn viel auszudrucken ist, weil dann nicht so viel Tinte oder Toner verbraucht wird. 

Wenn man dagegen nur am Bildschirm arbeitet, könnte im Plot-Bereich ein schwarzer Hinter-

grund günstiger sein. Das probiert man am besten aus. Alle Farben können mittels der Schiebe-

regler „rot“, „grün“ und „blau“ eingestellt werden.  

 Shortcuts können das Arbeiten oft erheblich erleichtern. Nach dem Betätigen der Schaltfläche 

Hot Keys stehen für die verschiedenen Bereiche Registerkarten zur Auswahl. Man wählt zu-

nächst eine Registerkarte, z.B. „Schematic“. Dort sind bereits Shortcuts grau hinterlegt eingetra-

gen. Möchte man einen Shortcut neu definieren, zeigt man mit der Maus auf das zugehörige 

graue Feld und führt dort einen Links-Klick aus. Danach wird einfach die neue Tasten-

Kombination eingetippt. Mit OK werden zum Schluss die Einstellungen wirksam.  

Die Shortcuts werden am besten so festgelegt, dass man sie sich leicht merken kann. Oft kann 

man sie an andere verwendete Programme anpassen. Die von mir verwendeten Shortcuts sind in 

der Datei „LTspiceIV.ini“ enthalten. Diese Datei steht auf dem Hochschul-Server zur Ver-

fügung; Pfad: „G:\docs\Etech\Cordes\SPICE\LT-SPICE\LTspiceIV.ini“.  

Auf der folgenden Seite ist eine Liste der von mir verwendeten Shortcuts zu finden.  

 

 Bild 33:  Farb-Einstellungen  

1) Gewünschte Registerkarte wählen, 
z.B. Schematic.  

2) Mit der Maus auf ein Objekt zeigen, 
z.B. das SPICE-Kommando .tran 10m 
und Links-Klick. Das Objekt wird im 
Fenster „Selected Item“ genannt.  

3) Gewünschte Farbe durch Betätigen 
der Schieberegler einstellen.  

4) Schaltfläche „Apply“ betätigen: Die 
Einstellung wird sofort übernommen.  

5) Auf das nächste Objekt zeigen, z.B. 
den Hintergrund usw.  

6) Zum Schluss mit „OK“ bestätigen.  
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LT-SPICE-Shortcuts 

Schaltbilder Shortcut Kurven Shortcut Symbole Shortcut 

Schaltungselement I Neue Kurve A Attribut-Editor A 

Leitung F3 Neues Plotfenster Ctrl+A Attribut-Fenster Ctrl+A 

Knoten F4     

Löschen F5  (Delete) Löschen F5  (Delete) Löschen F5 

Kopieren Ctrl+C   Kopieren Ctrl+C 

Verschieben M Verschieben M Verschieben M 

Verschieben, ein-

schließlich der Lei-

tungen (Drag) 

F8 Verschieben, ein-

schließlich der Lei-

tungen (Drag) 

F8 Verschieben, ein-

schließlich der Lei-

tungen (Drag) 

F8 

Undo Ctrl+Z Undo Ctrl+Z Undo Ctrl+Z 

Redo Ctrl+Y Redo Ctrl+Y Redo Ctrl+Y 

Text T Text T Text T 

Linie Ctrl+L Linie Ctrl+L Linie Ctrl+L 

Rechteck Alt+R Rechteck Alt+R Rechteck Alt+R 

Kreis K Kreis K Kreis K 

Kreisbogen B   Kreisbogen  B 

Spice-Anweisung S Autorange Vertical V   

Grid Ctrl+G Grid Ctrl+G   

Drehen Ctrl+R   Drehen Ctrl+R 

Textmarkierung O   Objektmarkierung O 

Spiegeln Ctrl+E   Spiegeln Ctrl+E 

Zoom Area Z Zoom Area Z Vergrößern Z 

Zoom back – Zoom back – Zoom back – 

View Fit  Home  View Fit Home    

Simulation starten  Leertaste Simulation starten Leertaste   

Simulation halt H Simulation halt H   

GND G Plot Setting öffnen P Neuer Pin P 

Widerstand R Pfeil Alt+P Pin-Tabelle  Ctrl+P 

Kondensator C Cursorposition  Alt+C   

Spule L Redraw X   

Diode D Reload Plot Setting  Y   

View Error Log E View Error Log E   

      

Netzliste Shortcut     

Simulation starten Ctrl+Leertaste     

Simulation Pause Ctrl+P     

Simulation halt Ctrl+H     

Undo Ctrl+Z     

Redo Ctrl+Y     

View Error Log Ctrl+E     

Anmerkung:  

Obwohl in der Liste große Buchstaben geschrieben sind, 

wird die Shift-Taste nicht betätigt. Es brauchen also nur 

kleine Buchstaben eingetippt zu werden!  
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